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Ricin is a complex toxin capable of crossing membranes and inactivating ribosomes by cleavage at a
specific site in the RNA. It is composed of two unrelated polypeptide chains, with the catalytic site in the 
alpha/beta A chain, two similar antiparallel-beta domains in the B chain, and four bound carbohydrates. 
Its crystal structure was determined by Robertus and colleagues at the Univ. of Texas, and is PDB file 
2AAI.

Kinemage 1 - a simple Calpha-backbone (to decorate later)
For an initial look at the ricin molecule, we will run a simple script on file 2AAI.pdb (384KB). Launch KiNG 
and open the file from its 'File | Import | Molecule' menu. When the Molikin dialog box of choices comes 
up, check the box labeled "disulfides" and then press 'As new kinemage', which will execute a simple 
script producing Calphas, disulfides, and non-water het groups for all subunits in the file. The resulting 
kinemage will appear in KiNG so you can look at it.

You should see Calpha backbones for the two ricin chains in different colors, with yellow disulfides and
several bound sugars (pink). Move it around by dragging with the mouse. Such a simple, default kinemage 
shows many of the features of the structure, and is useful for many purposes. Note, however, that the 
viewpoint is arbitrary, the default colors and the names and arrangements of buttons are not ideal, and 
the sugar units are not connected to the protein. If you want to show particular details and get your point 
across to someone unfamiliar with the structure, then there are many ways to make the kinemage more 
informative and persuasive.

Choosing and saving views
First move around to find a view that spreads out the 3 domains in the plane of the screen, with the A
chain (the white one) at the top. See if you can enlarge the zoom factor by a bit without going off the 
screen edges. Type "s" on the keyboard to toggle into stereo, to make sure your zoom and orientation 
allow seeing most of the important parts in stereo (you can check for that, even if you can't see stereo 
yourself). Try improving the depth-cueing by dragging the 'Clipping' slider until something gets clipped 
away in the back or front, and then back off a step or two. (You can also zoom and clip by dragging with 
the right mouse button.) Recenter using 'pick center' if needed. Alternately, hit the "f" key to toggle to 



moving flat on the screen rather than rotating; dragging at the top of the screen moves the center 
backward or forward. Once satisfied, choose the 'Views | Save current view' menu item, and save this 
with a name such as "overview". Move the image, then choose your view under the View menu, which 
should reproduce the view you just saved.

Next choose 'Edit | Find point'. In the dialog box, check that centering is on and ask for "177", which is
the active-site Glu of ricin; KiNG will center on Glu 177 (and mark it, if Markers are turned on). Zoom in 
somewhat, choose a view for the A chain that shows both the central beta sheet and the active-site 
Glu, and save it with a name of "A chain". Now pickcenter between the two domains of the B chain, 
zoom in, and save a view that shows the domains fairly equivalently, in a vertical orientation to allow 
for stereo. Locate the place where the chain moves between the two similar halves of the B chain, and 
make a note of that residue number: ________. (You will use it later to put the two domains under the 
control of separate buttons.)

Improving the colors and button names, and saving your modified kinemage
Turn on 'Edit / draw / delete' on the Tools pulldown menu. Check that 'Edit list props' is selected, then
click on a sugar atom. Click the white swatch (it will say "white" when the mouse hovers over it), and 
click OK. Now you need to change the colors of the two subunits, A to differ from the white sugars and 
B to contrast better with the yellow SS bonds. The "tint" colors work well for Calpha backbones, because 
they can be distinguished without overwhelming small features you want to emphasize. Make the A 
chain yellowtint and the B chain greentint (try out some other possibilities, too).

Select 'Reveal in hierarchy' from the 'Edit / draw / delete' tool palette, and pick a sugar atom. The
resulting dialog box will show you the program's internal data structure for this item. Notice the sugar 
lives in a list called "het", in a subgroup called "(implied)", in a group called "2AAI". Edit the group name 
to "sugars" by selecting the group ("2AAI") and clicking the 'Properties' button. (Notice that it has the 
'dominant' option below it checked, which hides its subgroup and list buttons on the button panel.) 
Accept the result, and see how the button has changed. Then edit the group names for the protein 
subunits, from "2AAI A" to "Ricin A ch" and from "2AAI B" to "B chain". It's a good idea to keep names
short, about 10 characters or less. If you're not sure which group corresponds to some part of the 
protein, use 'Reveal in hierarchy' again.

Choose 'Save as', under the File menu; you will be given a dialog box to locate and name the saved file.
Be sure to add ".kin" to the end of the file name. Choose 'File | Close all' to reset KiNG after saving the 
file.

Making more pieces to add to the kinemage
The carbohydrates in ricin are "N-linked" - bound to Asn sidechain N atoms. In order to find and show
those linkages, and produce other useful vectors for your kinemage, run Molikin on PDB file 2AAI again 
to produce 2 different types of output: a) vectors for the active-site Glu 177 sidechain in the A chain b) 
all the Asn sidechains of the B chain. To achieve this, click on the Molikin dialog you used before, which 
is now behind the main KiNG window. It should have one ball-and-stick entry with 'C-alpha trace' and 
'disulfides' selected. Click '(+) Ball & Stick' to add another ball-and-stick entry. Adjust the selection to 
chain A (only), residue 177, and only the 'protein', 'sidechain', and 'balls on N, O, P' boxes selected. Add 
a third ball-and-stick entry the same way, but for chain B, all residue numbers, and only Asn 
sidechains. Click 'As new kinemage' to see the results in KiNG. If you made a mistake, you can 'File | 
Close all' and adjust the settings in Molikin to try again.

Using Drawline to draw sugar-Asn bonds, and Prune to delete unused Asn
Zoom in on the B chain and turn off everything but the Asn sidechains and the sugars. Turn on 'Draw
line segments' in the 'Edit / draw / delete' tool. For each of the two long (5-sugar) carbohydrate chains, 
find an Asn whose Nd2 atom is close enough to be covalently bonded (around 1.4 Å) to a sugar atom; to
add a line for the bond, pick the two atoms. Change 'Shorten lines by' to 0.7, then, for each of the 
two-sugar chains, find an Asn whose Nd2 is H-bonded to a sugar atom (2.5-3 Å distance), and click on
the two atoms to add a shortened line to represent the H-bond. (Switch to 'Do nothing (navigate)' while 
measuring the distance, but if you accidentally draw an unwanted bond remove it with 'Undo drawing'.) 
Note the residue numbers of these four Asn: ________, ________, ________, ________.

The 'Edit / draw / delete' tool has 3 buttons for deleting stuff: 'Punch' deletes single vectors or two that



join at the point you picked; 'Prune' deletes a connected string of P, L, L vectors; and 'Auger' removes 
things in a circle around the picked point. 'Undo drawing' will undo previous deletions in reverse order, 
up to about 10 steps back. Find an Asn far from any sugars, and try out these functions. Then remove 
all the unconnected Asn's, using either 'Auger' or two prunes at the Cgamma branch point for each one. 
Save the modified kin.

Using a word processor to edit the kinemage file
Look at the file in your word processor or other editor (e.g. Notepad on Windows, TextEdit on Mac, gedit
on Linux). Make a new subgroup for the Glu 177 sidechain balllist and vectorlist (after the Calphas of 
the A chain), with {Glu 177} as its master name. Edit its vectorlist color to something bright, contrasting, 
and oxygenish, such as pink or hotpink.

Under the B chain group, edit the subgroup name to "{domain 1}". Look up the residue number you
identified as being the switch point between domains in the B chain, and divide the B chain Calphas 
into two vectorlists -- in order to do that, copy the subgroup and vectorlist lines and paste them in at 
the junction point; duplicate the switch-point Calpha, so it can be both the end of the domain 1 list and 
also the start of the domain 2 list. Edit the subgroup name to {domain 2} and the list color to bluetint. 
Put the correct vectorlist in each subgroup. Now paste in the Asn sidechains as two vectorlists, each 
under the correct subgroup (dividing them at the residue number you had determined). Edit the color to 
"sea" for the domain 1 Asns (to go with the greentint Calphas) and "sky" for the domain 2 ones, to go 
with the bluetint. Delete the subgroup line before the SS sidechains, divide them into two vectorlists, 
and move the first one up into the domain 1 subgroup; edit the name of their masters to "{SS}".

At the end there should be a "Drawn objs" group with the 4 bonds you drew between the Asn's and the
sugars. Delete the group, subgroup, and list lines, which should leave those bonds suitably at the end of 
the sugar vectors. At the top of the file, delete the duplicated header information that belongs with the 
"xtra" material, making sure that you still have your views for chainA and chainB.

Save as a plain text file (the formatting controls in word processor files will often break KiNG, so plain
text is much safer). Look at the resulting kinemage to see if you did what you intended and whether 
you like the results. Modify views, and note anything that needs to be changed.

You could have achieved a similar result in Molikin directly by creating additional ball-and-stick
entries: three for the backbone C-alphas and disulfides (chain A, chain B domain 1, chain B domain 2) 
and three for the sidechains and atom balls (A117; B46, B95, B135; B255).

Write text and caption
In KiNG again, press the 'Show Text' button in the lower right corner. In the text window, put a title at
the top in caps, your name(s) as author(s), then a blank line, "*{Kin 1}* Ricin A and B chain, with Glu 177, 
SS, and sugars", another blank line, and a paragraph or so about what a reader should look for in the 
kinemage, including a description of what is shown and what the colors mean. Leave in the PDB file 
name, at the bottom, but you may not want all the header information. Save the file. The *{Kin 1}* is 
hypertext: clicking in it will take you to kinemage 1. The hypertext Table of Contents will be very useful 
once you add more kinemages.

Before quitting, examine the kinemage again. If you were the reader, would you learn significantly
more from this version than from the original default kinemage? This example was more complex than 
most, to introduce you to a variety of authoring tools. We hope it convinced you that worrying about 
how the kinemage looks is worthwhile, and that the process is fun.



Kinemage 2 - A Ribbon Schematic of both Ricin Chains
Molikin can make either a simple, default ribbon with no secondary-structure information, or else it can
do arrows for beta strands, spiral ribbons for helices, and widened single splines for coil. In order to do 
the more interesting ribbons for both chains of ricin, you will need to use an edited PDB file called 
2AAIed.pdb (384KB), with "sheet" records for chain B as well as chain A added to the header. (2AAIed.pdb 
is available from http://kinemage.biochem.duke.edu/teaching/bch222/.)

Open the PDB file with File | Import | Molecule. Click '(-) All' to remove the default ball-and-stick
rendering, then '(+) Ribbons'. Accept the defaults and click 'As new kinemage'.

Adding details, and changing ribbon colors
In a word processor, look at the ribbon kinemage, which has vectorlists for the edges of strands,
vectorlists with "width4" for the splines in coil, and ribbonlists for the beta strands (and for alpha, if 
there were any). Give the group a name like {ricin A ch}. Just above that is a list of the masters; you can 
change the order of those lines in order to control the order of master buttons on the screen. Under the 
group, copy over the Gln 177 subgroup from your Kin. 1, to mark the active site.

Note the line that reads '@colorset= {betaA} lime' -- this is a way to treat colors as variables, and lets
you easily change the color of beta ribbons, which we will use to tell the chains apart. Edit the beta 
colorset for chain B to sky and change the group name to {ricin B ch}. Save as a plain text file.

Look at the kinemage, and save views for each chain. Make note of anything that needs fixing. Edit the
text and caption to say something suitable. Save the kinemage again.

Instead of making these changes in a word processor, you can do it from within KiNG. Use Molikin to
add a ball-and-stick rendering of Gln 177 at the active site. Use the Hierarchy window to change 
groups names, etc. There's no way to change colorsets from within KiNG, but you can activate 'Tools | 
Pick objects', and then choose 'Tools | Edit / draw / delete' and select 'Edit list props'. Now you can click 
on individual helices or strands and change their colors one at a time. When you're done, turn off 'Pick 
objects'. ('Pick objects' makes it easier to select a part of the ribbon itself, rather than accidentally 
picking on the black line that borders it.)



Kinemage 3 - Active Site, With Atom Balls and H-bonds

The 'Spherical crop' option, and other active-site details
Run Molikin on file 2AAI again. Do a ball-and-stick rendering with C-alphas, backbone, and sidechain.
Use 'Edit | Find point' to find the C-gamma of Glu 177 by entering "177 cb". Zoom in.

Pruning sidechains and main chain, and drawing H-bonds
Choose and save a view that gives a good closeup of the active site cleft. Turn off the Calphas and the
backbone; this is important or they will be deleted! Only the sidechains should be showing. From the 
'Edit / draw / delete' tool, choose 'Spherical crop' and set the radius to 10. Click the C-gamma and 
notice that most of the sidechains are pruned away. Now increase the radius to 14, turn back on the 
backbone (but not the C-alphas), and click the C-gamma again. Be careful with the spherical crop tool 
- you can't undo its actions. Prune or auger away all the sidechains except for the two Glu, the two Tyr, 
the Arg, and the Trp. Use 'Draw line segments' to draw in the sidechain H-bonds with 'shorten lines' set
to 0.7. There should be 3 H-bonds to main chain, from the Arg, Trp, and one Tyr. Now, prune or auger 
away all main chain except for one peptide's worth (from Calpha to Calpha) at each of those 3 H-bonds. 
Once you are close, then use 'punch' to trim down to the Calpha (this allows a smooth joining, later, 
between main chain and Calpha backbone).

Editing the backbone, and adding balls
Edit the kinemage you just saved, changing its number to 3. Delete the vectorlist line for the main chain
('mc'). For each of the 3 mainchain peptides, cut-and-paste it between the correct Calphas. Delete the 
"new group" group line, rename its subgroup as {sc Hbonds} and add the parameter "dominant", and 
color its vectorlist purple. Rename the other groups, etc., so that they will make a good button layout. 
Do the sidechains as a dominant subgroup. Move the Glu 177 vectors to a separate list, so they can be 
colored pink. Between the sidechain subgroup and its vectorlist, add the following two lines (note that 
the word "balllist" really does have 3 l's):

@balllist {sc O} color= red radius= .2
@balllist {sc N} color= sky radius= .2

Then COPY and paste all the sidechain oxygen atoms (from Glu and Tyr) under the first balllist and all
the sidechain nitrogen atoms (from Arg and Trp) under the second one. This will produce a ball & stick 
representation for those parts. If you will be using Mage to view this kinemage later, it is important to 
put the balls BEFORE their vectors, so that Mage can shorten those vectors appropriately to make the 
balls look like balls. (KiNG doesn't care what order they're in.) (Note that Molikin can also generate 
non-C balllists directly, as you did in Kin 1.) Look at the resulting Kin. 3, and edit text for it. Make a 
note of anything that needs to be fixed, and fix it.



Kinemage 4 - Superimposing the Two Domains of Ricin Chain B
Chain B has two domains that each have the "beta trefoil" fold; superimposing them can show how similar
they really are. We will use the beta strands, the disulfides, and especially 3 of the Trp sidechains as 
landmarks for doing the superposition in KiNG with its docking function.

Open 2AAI.pdb or 2AAIed.pdb in Molikin again. Create a ball and stick rendering of C-alphas and
disulfides for chain B, residues 7-138. Create a second one for Trp sidechains, chain B, residues 7-138. 
(The N-terminal tail is not equivalent and the domain changeover point is at about residue 138.) Click 'As 
new kinemage'. Now change both ranges to 138-355, and press 'Append to current'. (This ensures the two 
subdomains show up as separate groups, to facilitate docking.) Rename the groups to "Domain 1" and 
"Domain 2" if you like.

You should see all of chain B, with Trp sidechains in cyan and SS in yellow. Turn off the second button on
the panel (domain 2) and use 'Tools | Edit / draw / delete' to make the domain 1 Calphas another color, 
like lilactint. Drag with the mouse down and a bit left to get a view down the 3-fold axis of domain 1 - 
you should see 3 Trp sidechains as symmetrical "T" shapes, with a triangle of Calpha strands evenly 
behind a central opening. Recenter if necessary. Save this view with a name like "3-fold". There are 2 
other Trp in domain 1 that are not symmetrically related around the 3-fold; use 'Auger' (with the C-alphas 
hidden!) or 'Prune' to delete them. Turn on Domain 2 and make its Calphas some other color (maybe 
peachtint). Find the 3 symmetrical Trp in domain 2 and prune away the extra, fourth one.

The Dock 3-on-3 Function
To get the 3-point docking tool, choose 'Tools | Kin editing | Dock 3 on 3', which will pop up a new
small window. Pick the 3 Trp Calphas of domain 1 in counterclockwise (sequence) order, starting with 
the one between the two SS; numbered markers will appear in sky blue. This defines the "destination" 
for docking domain 2 (the "reference" object). Drag down and left (if you hit an atom, use eraselast) for 
a similar view of domain 2, and pick its 3 Trp Calphas also CCW starting between the SS. BEFORE 
PRESSING THE 'DOCK' BUTTON, turn OFF domain 1. Dock 3-on-3 moves whatever parts of the kinemage
are visible, and leaves alone those parts that are hidden. Domain 2 should jump on top of domain 1. 
Dock3on3 is not a root-mean-square function but superimposes the first point exactly, as you can now 
see. The other 2 Trp and the 2 SS all look offset in the same direction, so try this again. (Making a 
reasonable superposition is usually an iterative process.) Turn off domain 2 and pick CCW but starting 
with the 2nd Trp this time; then turn domain 2 on and 1 off, and pick the equivalent 3 Trp in the same 
order (you needn't worry about the markers, which are unpickable). With both domains on, this should 
show a good match. Which parts line up closely, and which parts differ?

Animating
Can you indeed see convincingly now that these two domains have the same fold? They are almost
certainly related by a gene duplication. To set up animation between the two structures, use 'Reveal in 
hierarchy' or 'Edit group props' from the 'Edit / draw / delete' tool to bring up group properties for 
Domain 1 and Domain 2. Check the 'animate' box. Notice that the buttons now have stars (*) in front of 
them. Then animate with the "a" key. Remember you can still turn on both at once. Save the kinemage.

Assembling a multi-part kinemage file
Save any kinemages you're currently working on. Then use 'File | Close all' to reset KiNG. Open the four
kinemage files you've made in sequence - first #1, then #2, etc. Edit the text window to make 
everything flow together, then choose 'File | Save as' and tell KiNG that you want to save all the open 
kinemages into one file. (You can accomplish the same thing in a word processor by cutting and pasting 
the kinemages one after another.)

You have now made a quite complicated kinemage file, which illustrates a number of interesting things
about ricin. Congratulations!
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